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Introduction to EndNote? 
• EndNote is a bibliographic management program 

designed to import, store and organize your references. 
 

• The program can automatically create and format 
bibliographies and in-text citations in many different 
referencing styles. 
 

• An EndNote library may be equated to a file or folder 
containing the references you have found. A library can 
contain up to 100,000 references. 
 

• Even though, it is possible to create several libraries, it is 
preferable to work with one library only for a particular 
dissertation. 
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To Create a New Library contd.: 
• Click on the EndNote icon         if it is already pinned to your task bar. 

The last library you used opens (if you had already created a library). 
• Alternatively, go to Start > Programs > Endnote. 
 

 
• Click on the File tab[1], and then 

click New [2]. 
• In the menu box that appears, 

type the name you want to give 
the file (e.g., BMI and BP Study) 
[3] in the File name box. 

• Select the location where the 
folder you had created for your 
EndNote Library is located (e.g., 
Desktop) [4]. 

• Find the folder (i.e., My EndNote 
Library ) [5], click on it, and then 
click Open [6]. 

• Finally click Save. 
• A new EndNote Library appears 

on your screen. 
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• Your EndNote references are stored in a 
database called a Library. EndNote libraries 
have the file extension .enl. This is the file you 
open. 

• Each library has a corresponding folder with 
the extension .data. This folder will have the 
same name as the library, and it is where 
images, PDF files etc are stored. 

• If you move, copy, rename or delete a library, 
remember to do the same with its 
corresponding Data folder. 

• There is no limit to the number of references 
you can store in a library, but it is 
recommended that you do not exceed 100,000 
to maintain efficient performance of the 
database. 
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1. Main tabs (including File, Edit, References, groups, Tools, Window and 
Help) for specific functions. 

2. Search / connectivity modes (i.e., local library [a], online search [b] and 
integrated [c] modes). 

3. For setting the reference style. 

4. For adding a new reference to the selected group. 

5. For finding the full text. 

6. For inserting citation (into your word document). 
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7. For formatting  bibliography (in word). 

8. For entering the search instructions. 

9. The Reference list Pane: Contains the list of the references found. 

10. The Tabs Pane:  This includes tabs of functions such as Reference, Preview 
and Attached PDF. 

11. Groups Pane: These are subsets of references saved for easy retrieval. 

12. For changing the layout of the interface. 



 
 

•       File tab: Clicking on the File tab displays a dialog box 

        which contains options such as New, Open Library,      

        Close Library, Save, Save As, Save a Copy, Revert,  

        Export, Import, print, etc.. 

 

• Edit tab: This contains functions such as Cut, Paste, 
Clear, Select All, Find and Replace, Font, Size, Style, 
Output styles etc.  

 

• References tab: This tab allows you to create new 
Reference, Edit References, Copy References To, E-
mail References, to Find References Updates, Find 
Duplicates, etc. 
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Referencing with EndNote contd. 
The EndNote Interface contd: 
Main tabs: 
 



 
 

•       Groups tab: This contains functions such as Create 
Group, Create Smart Group, Add References To, Create 
Group Set, hide Groups, etc. 

 

• Tools tab: This contains functions such as Search 
Library, Cite While You Write, Online Search, Format 
Paper, Sort Library, Library Summary, etc.  
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Referencing with EndNote contd. 
The EndNote Interface contd: 
Main tabs contd.: 
 

•    Window tab: This contains functions such as Tile     
      Vertically or Horizontally, Arrange  Icons, and Close All  
      Libraries. 

•     Help tab: This contains information on EndNote,      
       EndNote Training, EndNote Web, etc. 



Referencing with EndNote contd. 

10 

 

To set the reference style. 
• Click on the drop down arrow 

next to the Reference Style box 
[1], and select the style you want 
(e.g., Author Date) [2] from the 
menu box that appears. 

• If the style you want is not 
available in the box, click Select 
Another Style [3], and use the 
scroll bar [4] to find the style you 
want in the Choose A style menu 
box that appears. 

• Click the style you want, and click 
Choose [5]. 

• If you want to change to another 
style, repeat the procedure and 
choose the style you want. 
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To download references to your 
library: 

• Connect your computer to the 
internet. 

• Open the library (file) you want to 
download references to. 

• Click on the online search icon 
[1], (but it is preferable to use the 
integrated mode while searching 
for the first time so that the 
records also enter your local 
library at the same time). 

• Select the search engine you 
want (e.g., PubMed) [2], from the 
Online Search engines that 
appear. 

• The Connecting to Host box 
[3]appears with a bar showing 
the progress of the connection. 
Wait for it to connect. 
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To download references to 
your library: 
 

• Click on the drop down 
arrow next to the search 
term box [4], and select 
Title from the menu box 
that appears [5]. 

 
• You may wish to search 

with other options such 
Authors’ name, Journal, 
Year of publication, 
Publication type or date, 
etc. 
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To download references to your library 
contd.: 

• Type Prevalence of obesity [6] in the 
box for entering what the search term 
should contain. 

• Click on the drop down arrow next to 
the options box [7] and select Or from 
the options that appear. 

• Type Prevalence of hypertension [8] in 
the corresponding box for entering what 
the search term should contain. 

• Click on the drop down arrow next to 
the options box [9] on the next level and 
select And from the options that appear. 

• Type Nurses [10] in the corresponding 
box for entering what the search term 
should contain. 

• To add or delete a search level, click on 
the box with plus [11]or minus [12] sign. 

• Click Search [13]. 
• It was able to retrieve 3 records, click OK 

[14]. 
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To download references to 
your library contd.: 

• It is preferable to search 
with the key terms (e.g., 
Obesity instead of 
Prevalence of obesity 
and Hypertension 
instead of Prevalence of 
hypertension). 

• This yields more results, 
considering the fact that 
many authors may not 
necessarily include the 
word prevalence in the 
title of their work. 

• In this case 168 records 
were retrieved by 
searching with the key 
terms. 
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To download references to your 
library contd.: 

• Clicking on the Preview tab [15] 
gives a preview of the citation 
[16]. 

 
 
 
 

• Clicking on the Reference tab 
[17] gives the full details of the 
article, including the Abstract 
[18]. 
 
 

• After going through the 
abstracts, you may delete those 
that are not relevant to your 
study in your local library. 

 • References that are not 
available online, can be entered 
manually. 
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To enter references manually: 

• Click on the References 
tab [1], and select New 
Reference [2] in the 
menu box that appears. 

•  Alternatively, click the 
New Reference button 
[3] on the toolbar. 

• In the New Reference 
box that appears, use 
the drop down arrow [4] 
to select a Reference 
Type (e.g. Journal 
Article) [5]. 

• Enter the reference data 
in the relevant fields. 
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To enter references manually 
contd.: 

• For author’s names: Type the 
surname, then a comma, then 
a space, and then the first 
name(s) with no full stop (e.g., 
Danmakaranta, Omoileiwe 
Nwakuko)  

• Or , type the surname, then a 
comma, then a space, then the 
initials separated by a space 
(e.g., Danmakaranta, O N). 

• For a corporate author, type 
the full name followed by a 
comma (e.g., World Health 
Organization,). 

• The comma after a name tells 
EndNote that it needs to 
remain as entered. 

• Only type one author’s name 
per line, press Enter to go to a 
new line. 
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To enter references 
manually contd.: 

• Omit punctuation from 
the end of any entry 
(other than for the 
author/s) as EndNote 
formats the references. 

• Use the Tab key to move 
to the next field. 

• Use the arrow on the 
scroll bar [1] to scroll 
down to the remaining 
fields. 

• You do not need to type 
‘vol.’, ‘p.’, ‘pp.’ in the 
volume and pages fields. 



Referencing with EndNote contd. 

19 

 

To enter references manually contd.: 
• Click File [2], select Save [3], and close the New Reference 

window by clicking the small x button [4] at the upper right. 

 

 

• The newly entered 
reference [5] appears on 
the Reference list Pane 
(according to its 
alphabetical order). 

• Repeat the procedure for 
the other references one 
by one. 
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Organizing your library into Group Sets and 
Groups: 

• If you want to have a single library for all 
your research works (instead of having a 
separate library for each study) all you need 
to do is to create group sets (i.e., a group 
set for each study). 

• There is always a default New Group Set [1] 
which you can assign to your first study , all 
you need to do is to rename it (i.e., replace 
it with the name of your study [e.g. BMI and 
BP Status Study]). 

To rename the default New Group Set: 
• Right-click on the default New Group Set 

and click Rename Group Set [2] in the menu 
box that appears. 

 
• The box becomes active, type the name of 

your study in the box (e.g., BMI and BP 
Status Study) [3], to replace the default 
New Group Set and press Enter. 
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Organizing your library into Group 
Sets and Groups contd.: 

• You only need to create a new 
group set if the default New Group 
Set has been assigned to a study. 
 

 To create a new group set : 
• Click on Groups tab [1], and then 

click Create Group Set [2] in the 
menu box that appears. 
 

• In the New Group Set box [3] that 
appears with an active field, type 
the name of your new study (e.g., 
Telemedicine Study) and press 
Enter [4]. 

• Repeat the procedure for your 
subsequent studies. 
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Organizing your library in Group Sets and 
Groups contd.: 

• You can now organize each Group Set in 
Groups; for example, for the BMI and BP 
Status Study you can create groups for 
the respective chapters of the dissertation 
(Chapter 1: Introduction; Chapter 2: 
Literature Review; Chapter 3: Materials 
and Methods; and Chapter 5: Discussion). 

  
To create a new group: 
• Right-click on the Group Set for which you 

want to create Groups (e.g., BMI and BP 
Status Study) [1], and then click Create 
Group [2] in the menu box that appears. 

• In the New Group box that appears [3], 
type the name of the Group (e.g., Chapter 
1: Introduction) [4] and press Enter. 

 



Referencing with EndNote contd. 

23 

 

To create a new group contd.: 
• Repeat the procedure for the remaining 

groups (i.e., Chapter 2: Literature Review; 
Chapter 3: Materials and Methods; and 
Chapter 5: Discussion). 

• The next thing to do is to select and move 
the references into the groups you want 
them to be. 

 
To move a reference to a group: 
• Click on the reference you want to move 

to a group[1]. 
• Hold down the Left button of your cursor 

and drag the selected reference into the 
group you want it to be (e.g., Group 1: 
Introduction) [2]. 

• Repeat the procedure for the other 
selected references. 
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Searching for the full text of a selected 
reference: 

• EndNote allows you to search for the full 
text  (pdf version) of the references you 
have selected if they are available online 
(open access). 

To search for the full text of a selected 
reference (pdf version): 

• Connect your computer to the internet. 
• Click on the reference you want to find the 

full text [1], and then click the Find Full 
Text button [2]. 

• The task shows (i.e., searching for the full 
text) in the Find Full Text group [3]. After 
the search, the number of references 
Found and those Not found are also 
indicated. 

• Go to the Tab pane and click on the pdf 
icon of the full text found [4] to open it. 

• Finally, click on the Save button [5] to save 
it in a folder named PDF inside the 
EndNote Library.Data folder. 
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To insert a citation: 
• Open the EndNote library for 

the study and select the 
referencing style you want 
(e.g., Vancouver) [1]. 

• Open the MS Word 
document, place your cursor 
where you want to insert the 
citation and click on the 
EndNote tab [2]. 

• Go to the Bibliography group 
and use the drop down arrow 
in the Style box to find and 
then select the referencing 
style you had selected in the 
Endnote library (i.e., 
Vancouver) [3]. 

• Go to the Citations group 
and click on Go to EndNote 
[4]. 

• This takes you directly to the 
EndNote library.  
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To insert a citation contd.: 

• Click on the citation you 
want to insert [5]. 

• Click on the Insert 
Citation button [6]. 
 

• The in-text citation 
appears as an Arabic 
Numeral (e.g.,1) [7] in the 
body of the text. 
 

• The complete citation 
appears in your reference 
list (i.e., under the 
REFERENCES section) [8]. 
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Formatting the references: 
To change the referencing style (e.g., from 

Vancouver to Havard): 

• Highlight the whole references  in 
the references list in your MS word 
document [1] . 

• Click on the EndNote tab [2]. 
• Use the drop down arrow next to 

the Style box [3] to find and select 
the referencing style you want 
(e.g., Havard) [4]. 

• The referencing automatically 
changes to the new style both in 
the text [5] and reference list [6] . 
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Formatting the references contd.: 
To change the referencing style (e.g., from Vancouver to Havard contd.): 

• The next thing to do is to edit the selected referencing style to be 
in line with the format of the institution concerned (e.g., Usmanu 
Danfodiyo University, Sokoto [UDUS]).  

Differences: 
• In the UDUS format as 

compared to the Havard 
style: 

• Only the first letter of the 
authors’ surname is 
capitalized. 

• There is no comma after 
authors’ surnames. 

• There is no full stop after 
authors’ initials; and there is 
no space between them. 

• The year is enclosed in 
round brackets (). 

• Full stop is inserted after the 
journal title (instead of 
comma in Harvard). 

• Colon is inserted after the 
journal’s volume (instead of 
comma in Havard). 

UDUS 
Aggarwal HK, Jain 

D, Mor S, Yadav 

RK, Jain P (2018). 

Prevalence and 

Clinical Correlates 

of Microalbuminuria 

in Patients with 

Essential 

Hypertension - A 

Tertiary Care Center 

Cross Sectional 

Study. J Assoc 

Physicians India. 66: 

30-35. 
 

Havard 
AGGARWAL, H. K., 

JAIN, D., MOR, S., 

YADAV, R. K. & 

JAIN, P. 2018. 

Prevalence and 

Clinical Correlates of 

Microalbuminuria in 

Patients with 

Essential 

Hypertension - A 

Tertiary Care Center 

Cross Sectional Study. 

J Assoc Physicians 

India, 66, 30-35. 
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Formatting the 
references contd.: 

To edit Havard style: 

• Click on the Edit tab 
[1]. 

• Click Output Styles 
[2] in the menu box 
that appears, and 
then click Edit 
“Havard” [3] in the 
new menu box that 
appears. 
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Formatting the references contd.: 
To edit Havard style contd: 

• Go to the Bibliography group [4], 
click Author Name [5] and then go to 
the Name Format [6]in the menu 
that appears. 

• Use the drop down arrow next to First 
Author box [7] to select the format with 
First Author’s surname without comma [8]. 

• Use the drop down arrow next to Other 
authors box [9] to select the format with 
Other authors’ surname without comma 
[10]. 

• Use the drop down arrow next to 
Capitalization box [11] to select Normal 
[12]. 
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Formatting the references contd.: 
To edit Havard style contd: 

 
• Go back to the 

Bibliography 
group, and click 
Author Lists [12b]. 

• Go to Author 
Separators [12c], 
and delete the & 
signs [12d]in the 
before last boxes. 
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Formatting the references contd.: 
To edit Havard style contd: 

 • Use the drop down arrow next to Initials 
box [13] to select the initials format with 
no full stop after each letter, and no 
space between the letters [14]. 

• Go back to the 
Bibliography group 
and click Templates 
[15]. 

• In the menu that 
appears, go to the type 
of reference concerned 
(e.g., Journal Article) 
[16]. 
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Formatting the references contd.: 
To edit Havard style contd: 

 • Click on Year, and enclose it in round 
brackets [17]. 

• Click Yes [21] in the save changes to 
EndNote style dialog box that appears. 

• Change the comma sign after Journal to 
full stop [18]. 

• Change the comma sign after Volume to 
colon [19]. 

• Click on the small x 
button to close the 
view [20]. 

• Give the edited style a name (e.g., 
Havard UDUS format Copy) [22], 
and then click Save [23]. 

• Finally, select the new style in the Style boxes of your EndNote Library, and 
document. The referencing style automatically changes to the new style. 
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Formatting the references contd.: 
• If the reference list is not properly 

aligned (as shown), it can be edited 
through the EndNote library. 

 

To edit the reference list 
through the EndNote Library: 
• Open the EndNote library. 
• Clic Edit >> Output Styles >> Edit Vancouver. 
• In the menu on the left pane, under Bibliography, click Layout [1]. 
• Use the drop down arrow next to Hanging Indent to select All paragraphs 

[2]. 
 

• Use the small x button to close 
view, select Yes in the Save dialog 
box that appears, give it a name 
(e.g., Vancouver Aligned), and 
click Save (as previously 
illustrated). 

• Finally, select the new style in the 
style boxes of both the EndNote 
Library and your document (as 
previously illustrated). 
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Formatting the references contd.: 

• If the EndNote library is not 
accessible, the reference list can 
still be edited in the document. 

To edit the reference list in the 
document: 

• Highlight the whole reference 
list [1] in your MS Word 
document. 

• Right click your mouse and 
click Paragraph [2] in the 
menu that appears. 

• In the Paragraph menu box 
that appears, go to the 
Indentation group, and use 
the drop down arrow next to 
Special box [3] to find Hanging 
[4], click on it and then click 
OK [5]. 
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Formatting the references: 
To change the format of Vancouver style: 
• Open the EndNote library. 
• Clic Edit >> Output Styles >> Edit Vancouver. 
• In the menu on the left pane, under Citations, 

click Templates [1], and go to (Bibliography-
Number) [2]. 

• The options include: 
• If you want to change the in-text citation from 

round brackets                       to square brackets           
just change (Bibliography-Number) to 
[Bibliography-Number]. [3] 

• If you want to change the in-text citation from 
square brackets sitting                      to square 
brackets superscripted                    , highlight 
[Bibliography-Number] and click on A1 [4] on top 
of editing window. Please note that for brackets 
sitting, the in-text citation comes before the full 
stop, while superscripted citations (whether in 
brackets or open) come after the full stop. 

• If you want superscripted open                  , just 
delete the brackets [3b] and click on A1 [4]. 

• Close the view, name and save the new style (e.g., Vancouver  Superscripted). 
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Formatting the references contd.: 
• When the dissertation is completed you may wish to remove the field codes 

before submitting it (but in the case of a journal article, the field codes should be 
removed before submitting it). 

 

To remove the field codes: 
• Open your document, click the 

EndNote tab [1], go to the 
Bibliography group [2] and click 
on the drop down arrow next to 
Convert Citation and 
Bibliography [3]. 

• In the menu box that appears, 
click Convert to Plain Text [4]. 

• In the dialog box that appears 
regarding saving the original 
document (with field codes) 
before converting it to plain text, 
select YES [5]. 

• Retain the original name and 
location and click Save. 

• Also save the new version of the document (without field codes) created. 
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    C-International Research Consultancy 

                          Our Services 
                 Design or Review of Protocol / Proposal 

We provide technical support in the design of study protocol / proposal. We provide guidance on 

formulation of research topic, specific objectives, research questions, and research hypothesis. We 

provide technical support regarding choice of appropriate study design, sample size estimation and 

sampling technique; as well as choice of appropriate method and instrument of data collection, and data 

management. We also review protocol / proposal and provide guidance on how to improve the quality in 

compliance with the guidelines of the institution concerned. 

                 Development of Data Collection Instrument 

We provide technical support in the development and validation of data collection instrument. We build 

questionnaires into the Open Data Kit (ODK) software for data collection with android phones. This saves 

the cost of printing questionnaires, makes data collection easier, eliminates non-response, enables the 

researcher to monitor the research assistants recruited for data collection (particularly, when and where 

each questionnaire was administered, taking pictures of relevant locations, etc), and eliminates the 

stressful data entry stage that usually follows completion of data collection. 

       Design of Database, Data Analysis and Interpretation of Results 

We provide technical support in the design of database, data entry, data analysis and interpretation of 

results. However, collecting data with the ODK software (instead of printed questionnaires) removes the 

need for (and the cost of) designing database and data entry. 

           Design or Review of Dissertation / Thesis / Project Report 

We provide technical support in the design of dissertation / thesis / project report (in compliance with the 

guidelines of the institution concerned). We provide guidance on data presentation (including creation and 

formatting of tables and charts).  We also review dissertation / thesis / project report and provide guidance 

on how to improve the quality in compliance with the guidelines of the institution concerned 

                              Manuscript Development 

We provide technical support in the development of manuscript (for publication of 

article extracted from completed Dissertation, Thesis and Project report). 


